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1.1. Section 1- Akkadian Console Operator
Overview
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1.1.1. Starting Console Operator
To start Console Operator:

1. Double-click the desktop icon.
2. The Login Window will appear. If the Login Windows does not appear, aCO has not been configured.
Please contact your administrator for further assistance.
3. Enter your User Id and Password and click OK.
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1.1.2. Console Operator Icons
This icon chart is designed to help guide you through Akkadian Console.

Status Icons Shortcut Key What It Means

N/A The line is idle/open

N/A There is an incoming call

N/A The line is in use

N/A Delete the number in the dial box

c Answers the call

Ctrl + H Hangs up the call

N/A Calls the number input in the dial box

Ctrl + L Puts the highlighted call on Hold

N/A The highlighted call will turn yellow when on hold for 60 seconds

N/A The highlighted call will turn red when on hold for 120 seconds

Ctrl + L Resume the highlighted call
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Ctrl + X Conduct a Blind Transfer

Ctrl + T Conduct a Consult Transfer

Ctrl + R Directly Transfer two lines together

Ctrl + C Initiate a Conference Call

Ctrl + J Join two calls to create a conference call

Ctrl + P Park an active call

N/A Revert a call in Park

Ctrl + O Transfer to Voicemail

N/A Call Voicemail

N/A Open the Dial Pad

N/A HLOG
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1.1.3. Console Operator Interface
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1.2. Section 2 – Akkadian Console Operator
Call Control
This section describes the various methods available to make and control calls.
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1.3. Section 3 – Customizing Akkadian
Console Operator
The Console Operator interface is very customizable. This sections provides details on the different options
available to customize interface.
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1.3.1. Rearranging Console Operator Panels
Using Drag-and-Drop
Console Operator provides the ability to rearrange the panels using your mouse:

1. Click and Hold the window you would like to move as demonstrated in figure 3.1
2. Use the Guide Arrows to drag and drop the window to a new location

Note: If you drop the window into the middle section of the guide arrows, the selected window will now
become a tab.

Figure 3.1
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1.3.2. Managing Panels Using the Toolbar
Console Operator provides the ability to managed panels using the panel toolbar. Each panel has three
icons as shown in figure 3.2.1.

Figure 3.2.1

1. – The Menu icon provides four options :

• Floating – Undocks the panel allowing it to float outside the main application
• Docked – Default setting where the panel is docked in the main application
• Sliding – Enables the panel to slide out from the left side of the application
• Hidden – Removes the panel from the application

2. – The Make Sliding icon provides as one-click method to activate the sliding panel feature.
3. – The Make Hidden icons provides a one-click method to remove the panel from the application.

Note: To restore hidden panels, see Section 3.3.
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1.3.3. Managing the Console Using the
Application Control Menu
The Console Application Control Menu provides additional methods to customize the Console Operator
interface.

1. Preferences
2. View

The Application Control Menu can be accessed by clicking on the icon located in the upper right-hand
corner of the application as shown in figure 3.3.1.

Figure 3.3.1
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1.3.3.1. Configuring Preferences
Preferences can be used to modify the following settings:

Font Size Use the drop-down arrow to choose between sizes 10-18 font.

Font Style Use the drop-down arrow to choose between Normal and Bold.

Language Use the drop-down arrow to choose between English, Spanish and French.

Theme Use the drop-down arrow to choose between Default, Expression Dark, or High Contrast.

Search Behavior Use the drop-down arrow to choose between Start with and Contains.

Shortcut Keys Define the keyboard shortcuts aCO will use to perform call control tasks

To access Preferences:

1. Click the icon and go to Preferences.
2. Adjust the desired setting.
3. Press the OK button to confirm changes or press the Cancel button to close the preferences window.
4. To reset all changes to default, click the Restore default button.
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1.3.3.2. Configuring Views
The View menu allows you to quickly toggle the application between different layouts as well as restore
hidden panels.

The View menu provides three different options:

1. Layout – change the application panel layout
2. Panels – Used to restore hidden panels
3. Window – Reset the application Window to the default size
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1.3.3.2.1. Changing the Layout
To change the layout:

1. Click the icon and go to * View.*
2. Select Layout.
3. Select the desired Layout.
• Vertical – Organizes the panels in a vertical format.
• Normal – Resets the panels back to default, but does not update tabs within the panels.
• Reset to Default – Resets all panels and tabs back to the default layout.
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1.3.3.2.2. Restoring Panels
To access the Panels menu:

1. Click the icon and go to View.
2. Select Panels.
3. Select the Panel to restore from the list.

4. To reset all changes to default, click the Restore default button.
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1.3.3.2.3. Resetting the Console Window
To reset the Window view:

1. Click the icon and go to View.
2. Select Window.
3. Select the Reset View.
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1.3.4. Configuring Lines
Console Operator automatically display all lines on the phone associated with the console. To improve the
call handling experience, Console Operator provides several options to customize each line in the console.

Feature Description

Add Label Add an alphanumeric label to a line to better identify the line.

Silence Line Prevent the console from displaying any call activity for a line.

Change Color Assign a color to a line which is applied to all calls for that line.

Notes Assign a note to a line.
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1.3.4.1. Labeling a Line
In Console Operator, to better identify lines, you can add a label.

To Label a line:

1. Right-click on the line.
2. Select Add Label.
3. In the New Name: field, enter the desired label.
4. Click OK to save your changes.
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1.3.4.2. Silencing a Line
Silencing a line prevents the console from displaying any call activity for that line in the Calls Panel.

To Silence a line:

1. Right-click on the line.
2. Select Silence Line.

3. icon will appear next to the Line.

To Unsilence a line:

1. Right-click on the line.
2. Select Silence Line.
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1.3.4.3. Changing a Line Color
Changing the line color can help better identify calls. When a color is assigned to a line, it automatically
display from all call activity on that line in the Calls Panel.

To change the line color:

1. Right-click on the line.
2. Select Change Color.
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1.4. Section 4 – Managing Speed Dials
Console Operator allows for an unlimited number of speed dials. Speed dials can be organized into groups
with the ability to search across a single or all groups. This sections will cover the steps necessary to
manage speed dials, including, adding, editing deleting and importing speed dials.

Akkadian Labs Akkadian Console - 4

Page 31 of 45



1.4.1. Adding Speed Dials
To add Speed Dials:

Using Method 1:

1. Right-click anywhere in the speed dial group.
2. From the menu, select Add.
3. Enter the speed dial information in the Add Speed Dials window.

Name Speed Dial Name (Required)

Number Speed Dial Number (Required)

Email Email (Optional)

4. Click OK to save the changes.

Using Method 2:

1. Search for a contact in Directories.
2. Using the mouse, drag and drop the Directory entry into a Speed Dial Group.
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1.4.2. Editing Speed Dials
To Edit a Speed Dial:

1. Right-click on the speed dial.
2. From the menu, select Edit.
3. Update the speed dial information.
4. Click OK to save the changes.
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1.4.3. Deleting Speed Dials
1. Right-click on the speed dial.
2. From the menu, select Delete.
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1.4.4. Adding Speed Dial Groups
Speed Dial Groups allow you to organize speed dials in to groups. Speed Dial Groups can contain an
unlimited number of speed dials and can be individually searched. By default, the Console Operator is
configured with a single Speed Dial Group named “Contacts”. This group can be renamed or deleted.

To Add a Speed Dial Group:

1. Right-click on an existing Speed Dial Group
2. From the menu, click New.
3. Enter the Speed Dial Group name in the Name field.
4. Click OK to save the new Speed Dial Group.
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1.4.5. Renaming Speed Dial Groups
To Rename a Speed Dial Group:

1. Right-click on the Speed Dial Group
2. From the menu, click Rename.
3. Enter the new Speed Dial Group name.
4. Click OK to save the changes.
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1.4.6. Deleting Speed Dial Groups
To Delete a Speed Dial Group:

5. Right-click on the Speed Dial Group
6. From the menu, click Delete.
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1.4.7. Search for Speed Dials
Console Operator provides the ability to search Speed Dials using the Name and or Number fields. You can
search within a Speed Dial Group or across all Speed Dial Groups using Search All Tabs.

To Search for Speed Dials within a Speed Dial Group

1. Click on the Speed Dial Group.
2. In the Name and or Number fields, enter the search criteria.

To Search for Speed Dials across all Speed Dial Groups

1. Click on the Search All Tabs group.
2. In the Name and or Number fields, enter the search criteria.
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1.4.8. Add/Remove Speed Dial Column
Headers
This feature allows the column headers to be added or removed from the Speed Dial display.

1. Right click on any column header and click Add/Remove Column.
2. A pop-up window will appear with a list of all column.
3. To make a header visible, check the corresponding box.
4. To remove a header uncheck the corresponding box.
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1.4.9. Importing Speed Dials
Speed Dials can be imported using a CSV file.

To Import Speed Dials:

1. Right-click within a Speed Dial Group.
2. From the Menu, select CSV-file Template.
3. Enter the speed dial to import in the template and save the file.
4. Select the target Speed Dial Group for the import.
5. Right-click within the Speed Dial Group.
6. From the Menu, select Import from CSV.
7. Select Local and select the file created in step 3.
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1.4.10. Exporting a Speed Dials
Speed Dials can be exported from any Speed Group in Console Operator. This can be useful to copy Speed
Dial Groups between Console Operators.

To Export Speed Dials:

1. Right-click within the Speed Dial Group you wish to export.
2. From the Menu, select Export to CSV.
3. Save the CSV file to the desired location.
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1.5. Section 5 – Using Notes in Akkadian
Opertor Console
Operator Console provides the ability to add notes for lines, active calls, parked calls, directory entries, and
speed dials.
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1.5.1. Adding a Note
To add a Notes for a lines, active calls, parked calls, directory entries, or speed dials:

1. Right-click on entity to which you want to add Notes
2. From the Menu, click Notes.
3. A text box will appear where you can type in your note.
4. Click Save to add the note.
5. To add additional notes, repeat steps 1-4.
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1.5.2. Viewing and Editting Notes
To View or Edit existing Notes:

1. Click on the icon
2. To edit a Note, select the Note and edit the note in the text box.
3. Click Save.
4. To edit additional notes, repeat steps 2 – 3.
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1.6. Section 6 – Help Menu
The Operator Console Help menu provides the ability to access documentation and gather logs to assist
with troubleshooting.

To access the Help menu:

1. Click the icon and go to Help.
2. Select from the following options:

• Online User Guide: Access akkadian Console Operator online user guide.
• Report a Bug: This will gather all necessary log files and place them into a single .zip file on your

desktop. These files can then be emailed to support@akkadianlabs.com for analysis.
• About: Access Akkadian Console Operator version information, link to the Akkadian Console

Operator Product Website, End User Documentation, and to send email for Akkadian Console
Operator Licensing.
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